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The aim of this book is to give you, as a committee member, all of the information that you need 
to successfully run your society and take advantage of all of the services BUGS has to offer you. 
 
Please make sure you look at the new accreditation available to you both through an internal 
programme and through Millennium Volunteers – all information can be found from page 8. 
 
We recognise that all societies, Standing Societies and Associations are different sizes and are at 
different stages of development. This Handbook has been produced to help all groups. For 
developing or new groups then please do as much as you can to make your group a success and 
please ask for help and advise if you get stuck. For older more developed groups if you want help 
beyond this book, for example with long term planning then please come and ask. 
 
As a committee member, you will play a major role in running activities that many students will 
benefit from whilst at university. This role will give you the opportunity to learn numerous 
transferable skills that will help you in getting a job when you leave Birmingham. 
 
Skills that you will gain include:

o Organisational   
o Time keeping 
o Prioritisation 
o Team work 
o Leadership 
o Communication 
o Marketing and promotion 
o Administration  
 

o Decision Making 
o Budget Managing 
o Event Management 
o Assertiveness 
o Problem Solving 
o Stress Management 
o Presentation 

 

Depending on your society, you will also gain many more specialist skills.  
 
If you want to develop any of these skills further or to learn how to apply the above skills in 
interviews and on applications then come along to our CIA training sessions – programmes are 
available at the Basement counter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

POLICY 
 
Throughout this handbook there are boxes like this. They contain ‘operational policy’ that has 
been agreed by Guild council. Guild Council is the Sovereign body of the Guild and as a 
society you have a seat on it which you must use.  
 
All policy has been agreed by the student body and therefore must be followed.  
 
If you wish to change or add to any of the policy in this book, or make new policy then you 
can do so by writing a motion to Guild Council. 

Good luck with your group this year!  
 
Megan Shute 
Vice President (Student Activities) 2004 - 2005
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This handbook includes most information regarding how to run your society.  
We also have 2 separate handbooks with more details these are: 
 

• Health and Safety 
• Guild Council 

 
Both of these include essential information and are available from the 
Basement Counter. 
 
Important information can also be found at: 
 
www.bugs.bham.ac.uk/getinvolved 
 
www.involvebirmingham.org 

- 3 - 





Student Group Handbook 04/05 

t
 

 
These are the staff who you wi
While we are all happy to help 
expertise. 
 
Finance and Student Group 
 
I oversee the smooth running o
for student group finances and
me whatever your query; whet
book or discuss your groups tra
into the basement. The baseme
the running of your society, so
important information or altern
pigeonhole. Stay in touch and 
 
Contact: basement@bugs.bham
 
Megan Shute – Vice Preside
 
Hi, I’m the Vice President respo
training, societies and standing
associations with the VP (Welfa
advice, general support, feedba
strategic decisions. You can us
meetings, Guild Council and to
all this year and making all gro
 
Contact: vpsa@bugs.bham.ac.
 
Lone Dykes – Transport Coo
 
Hi I deal with minibuses and ca
vehicles. I will give you prices 
behind the counter so I’ m sure
 
Contact: l.dykes@bham.ac.uk 
 
Lisa Clark – Reservations 
 
Hi, I book out all the rooms in 
functions in any of the Guild ba
charge to Guild recognized soc
requirements, i.e. tickets, secu
of booking. At the end of each 
book out rooms for the followin
served basis. You are also welc
to availability, please make sur
forward to meeting you ! 
 
Contact: l.clark@bugs.bham.ac
 
Daniel Avery – Technical Su
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technical requirements for any 
1. The Basemen
1.1 Front Line Staff 

ll deal with regularly while running your society.  
you with any questions, some staff have specific 

Coordinator 

f the basement counter. I am mainly responsible 
 health and safety but you can come and talk to 
her you have problems with your AGM, want to 
ining needs, or want advice on your publicity, pop 
nt counter is the source of all your information for 

 look out for posters and emails informing you of 
atively pop down and see us when you check you 
I hope to see you soon! 

.ac.uk 

nt (Student Activities) (VPSA) 

nsible for the strategic running of all volunteering, 
 societies and I share responsibilities for the 
re) Emma Hooks. Come to me for constitutional 
ck about BUGS and how we run student groups or 

e me to represent your views at executive 
 the University. I look forward to working with you 
ups more successful. 

uk 

rdinator 

r bookings. Come to me to book driver tests and 
and then book them with the University. I work 
 I’ll see you around. 

the Guild, and help you to arrange society 
rs. All bookable rooms in the Guild are free of 
ieties. There may be additional charges for specific 
rity, bars etc, and these will be advised at the time 
term, forms are made available in order for you to 
g term. Rooms are allocated on a first come, first 
ome to book rooms as and when needed, subject 
e you bring your committee Card with you. I look 

.uk  

pport Coordinator  

cal Support Co-ordinator.  My job is to fulfil the 
events you may be planning both inside and 
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outside the Guild.  Whatever you need, be it a microphone for promoting events 
in Mermaid Square, technical support for a society night in Joes or the 
Underground or a full sound and lighting installation for a large scale event in the 
Deb Hall, myself and the Technical Services team are here to help you.  You can 
find me in the Basement or in the Technical Office which is located behind the 
Deb Hall on the first floor of the Guild. 
 
Contact: d.avery@bugs.bham.ac.uk 
 
Cassie Manly and Fliss Harrison – Involve Coordinators 
 
Hello! We work in the Involve office in The Basement and manage the Millennium 
Volunteers scheme here at BUGS.  MV provides accreditation to volunteers and 
student groups for the volunteering you do. We are responsible for marketing 
volunteering opportunities with both student led projects and local charities and 
organisations.  We also support volunteers in the development of Spread the 
Secret and the Big V.  We source new opportunities with charities for volunteers 
and network with national organisations to explore funding options for the 
continuation of our project. For more information, see our website 
www.involvebirmingham.org
 
Contact: 
c.manly@bugs.bham.ac.uk or f.harrison@bugs.bham.ac.uk  
 
Andrew Bartley – Involve Project Coordinator (Training) 
 
Hi, I’m Andrew and I’m responsible for overseeing volunteer training within 
BUGS. I design and create training in accordance with the needs of voluntary 
projects and liaise with external organisations who offer training and advice for 
volunteers. I am also responsible for the marketing and promoting of training 
sessions and for networking with other students volunteering organisations within 
other universities. 
 
Contact: a.bartley@bugs.bham.ac.uk 
 
Sam Champion – Involve Intern 
 
Hi I am working as a graduate Intern for Involve. I work closely with every part of the 
Involve department. The main areas of my work are in the training of student volunteers, 
supporting student coordinators on existing projects, developing new student volunteering 
ideas/projects and helping to strengthen Involve's links with external charities and 
organizations. Come and see me if you want to know more about Involve or want to start 
volunteering  
 
Contact: s.champion@bugs.bham.ac.uk 
 
Student Staff 
 
Both the Basement and involve have student staff who are involved in much of 
the day to day running of the department. They will often be your first port of call 
so any queries you have then they are the people to ask. 
 
Contact: 
basement@bugs.bham.ac.uk or involve@bugs.bham.ac.uk 
 
For more details about either department you can also use our website which 
includes all of the information you need to keep in touch with what’s going on at 
BUGS: www.bugs.bham.ac.uk/getinvolved, www.involvebirmingham.org 

- 6 - 



Student Group Handbook 04/05 

1.2 How do Student Groups fit into BUGS? 
 

Student groups are a central part of BUGS. The activities which take place both 
within and outside the Guild are both supported and part funded by BUGS and 
they have played a central role in our previous mission statement “enhancing the 
student experience” and our current strategic plan. 
 

BUGS’s Vision: 
 

To lead the student experience and be at the heart of the student life 
To work within the Student movement to create positive change in the 

student community 
To act with and for our students in all that we do 

 
Specifically our student goals include: 

 
Students are our fundamental reason for being. Our aim is to be known 

and valued as the core provider of representation, social and 
development opportunities at the University 

 
To enable all students to participate in student life and develop skills for 

the future, including opportunities to enhance employability 
 
Constitutionally Officers are responsible for ensuring that the activities which 
Associations and Standing Societies run are always available to students Thus 
making them, along with societies, integral to the work of BUGS. This can be seen 
most clearly in part of BUGS objects which states that we will from time to time 
recognise new societies. 
 
Societies, Standing Societies and Associations are central to providing democratic 
consultation and feedback within BUGS. Each group has one seat on Guild Council 
and Associations have two to make this link to Guild democracy even stronger. 
 
With around 6000 students (that’s about a quarter of the university!) registered 
as being involved in Societies, Standing Societies and Associations it is clear that 
BUGS is committed to their success and development. 
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1.3 CIA - CV Improvements and Activities 
 
The CIA programme is open to any student at the University of Birmingham.  The 
CIA programme provides activities and training sessions for students who want to 
gain some key skills, who want to get into the employment industry, and for 
students on volunteering projects.   
 
By September the CIA project will have an accreditation scheme, which will help 
you to promote the skills you have learned at University to future employers. 
 
One of the key points of the CIA programme is to help you become even more 
employable at the end of your student life.   
 
The activities are run by Student Groups members and are anything from 
paintball trips to hitch hiking to Newquay 
   
The training sessions are informative and interactive which means there will be 
plenty of opportunity for learning through discussions, scenarios, team and 
individual work. The sessions last for about two hours and anything from 4 to 25 
students attend one session.    
 
The sessions full under three main headings: 
 

1. Key Skills training sessions:  these Basement sessions are those that are 
important to your own personal development. These are the skills that 
graduate recruiters are increasingly finding more important.  They cover a 
variety of skills including team working, leadership skills and negotiation.   

 
2. Work Experience sessions:  The Job Zone work with the university careers 

centre and provide training opportunities for you to gain valuable 
employability skills. The sessions included are CV workshops, work 
experience for international students, making the most of your work 
experience and much more.   

 
3. Involve Volunteering: Provides all students with a huge variety of 

volunteering opportunities ranging from working with children, 
conservation, art, fundraising and much, much more.  Extensive training is 
provided ensuring all volunteers have the relevant skills and knowledge to 
get the most out of their volunteering experience.   

 

To book your place on any of the courses please come along to the Basement 
counter and leave a £2 refundable deposit to confirm your place.  

For more information please e-mail basement@bugs.bham.ac.uk ,come to The 
Basement, Jobzone or Involve or look on www.bugs.bham.ac.uk/getinvolved/cia  
If you have any training needs please do not hesitate to e-mail us on the above 
address. 

For more training in and around the University please look out for the sessions 
provided by Student Support and Counselling. Also look out for the Careers 
Centre Autumn Events booklet, available from Careers and the Jobzone. The 
Careers Centre has a whole range of resources to help you find and get a summer 
placement, 12-month placement or permanent work upon graduation. 
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1.4 Accreditation 
 

As a member of a society committee you often don’t get the recognition you 
deserve. This year we have developed an internal accreditation scheme to 
celebrate the achievements of as many students as possible. At the moment this 
is only internally accredited but we are looking for the University and possibly a 
Blue Chip company to get on board. More details will follow throughout the term. 
 
You need to start at bronze and work your way up.  For those of you who have 
already been involved we are happy to backdate the work you have done. 
 
Signup forms are available from the Basement counter. 
 
Bronze: Getting involved  
 

• Attend any four CIA training sessions and write a self-evaluation form at 
the end of each session.   

 
Be a member of at least one of the following: 
 

• Student group (This includes sport clubs, societies, volunteering group and 
residencies), Student rep, A student mentor  

 
Silver:  Being a leader/motivator/activist/ coordinator – 
 

• Attend a further two training sessions writing a self-evaluation form for 
each. 

 
And been one or more of following:  
 

• A member of Guild council 
• A member of the Guild executive committee  
• A committee member of any student group  
• A committee member of any Guild committee 
• A student trainer  
• A member of student rep committee 
• A Student ambassador 
• A Senior assistance 

 
Gold: Excelling at level two  
 

• Attend two  training sessions including one on employability AND 
 
• Active member of SENATE (Student Rep) 
• A member of the executive committee  
 
• Or have been involved in at least four of the below  

o A member of Guild council 
o A committee member of any society 
o A Committee member of an Association or Standing society 
o A committee member of any Guild committee 
o A student trainer  
o A Being on the student rep committee 
o A Student ambassador 
• A Senior assistance  
• Hold your 200 MV Certificate 
 

This is subject to change as on going to print was still at consultation stage 
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1.5 Involve Volunteering
 

Involve is BUGS’s volunteering department. If you’re a volunteering society or 
student led project then you will have a lot of contact with Involve as they can 
offer tailor made volunteer training for you and offer project support. 
 
Apart from the work Involve does directly with volunteering societies it also 
places hundreds of students in volunteering placements with local charities and 
organisations.  If you’d like to take part in a one off volunteering opportunity or 
do something more regularly then they are the people to go to. 
 
All of Involve’s work focuses on wider community benefit and they play a major 
role alongside The Basement in improving the University’s reputation and raising 
the profile of BUGS both locally and nationally. 
 
If you are not a student led volunteering project but would like to get involved in 
volunteering in some way, there are loads of opportunities.  If you have any ideas 
of how you would like to get involved, please email involve@bugs.bham.ac.uk, or 
have a look at the Involve website, www.involvebirmingham.org.  
 
Examples of how you or your student group could get involved: 
 

o Running a workshop for a kids’ Creative Energy Day 
o Using your activity to raise funds for a local charity 
o Supporting widening participation by doing work in schools 

 
 

1.6 Millennium Volunteers (MV) 
 

MV is a Government funded scheme that accredits volunteering done by young 
people aged 16 to 24. Anyone who gives up their time for free, for the 
benefit of others can join this scheme and gain certification for 100 and 
200 hours of work. All you need to do is attend an Involve induction or society 
training and think about how your activity benefits others – by running a society 
this isn’t hard! 
 
The Guild has always included traditional volunteering under this scheme but 
from September 04 will also include committee members of all student groups. 
MV will accredit the following: 
 

o Student Action for Refuges (STAR) – community volunteering 
o ComAc 
o Conservation Volunteers 
o Niteline 
o LINKS 
o Medsin 
o Ravens 
o Spread the Secret 
o BUSAG 
o Duke of Edinburgh 
o Student Tutoring 
o Student Advice 
o Student Reps 
o Work with external charities 
o Wider community volunteering 
o Running any training/teaching 
o Representative roles i.e. non sabbaticals, student reps, youth forums, 

Guild councillors 
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o Fundraising for charities or societies (not including social events) 
o Time spent organising an event 
o General admin for a group 
o Welfare campaigning 
o Planning/fundraising based in the UK for international volunteering 
o Freshers reps 
o Stewards at Carnage 
o Travel and planning time for any of the above 
o Any committee member  
 

Unfortunately MV CANNOT accredit the following: 
 

o General taking part in societies not mentioned above  
o Hours spent on Carnage/Hitchhike unless you are a steward/organiser 
o International Volunteering (unless you’re going as a helper with a group 

from the UK e.g. helping on an overseas holiday for a UK based group for 
people with disabilities like SENSE) 

 
MV is government funded therefore places restrictions on: 

o Fees Marching 
o Political Campaigning 

 
There are also some grey areas such as work with religious groups or 
organisations which will need to be dealt with on a case by case basis. 
 
If you have any questions about this, please ask Cassie or Fliss (Involve MV co-
ordinators) or Megan (VPSA).  Where an activity is not specified above, their 
decision will be final. 
 
To gain MV accreditation, you will need to attend an initial training session (either 
induction or during society training), regularly submit timesheets (via email or on 
paper) to Involve staff and on achieving 200 hours complete a questionnaire.  
You must also consider in what way your volunteering benefits others. 
 
 

For more details email involve@bugs.bham.ac.uk or ask at the counter 
 
 

1.7 Frequently Asked Questions 
 
If your still not sure who to go to then use the guide below to help you – if in 
doubt use the basement counter! 
 

Reason Staff 
member 

Location Email They 
contact 

General 
questions/ 
Queries 

Counter 
staff 

Basement  basement@bugs.bham.ac.uk Varies 

Finance Finance and 
Student 
Group 
Coordinator 

Basement 
Counter 

basement@bugs.bham.ac.uk Finance 
Dept or 
VPSA 

Support for 
an Event 

Dan Avery / 
Lisa Clark 

Basement/  
Reception 

d.avery@bugs.bham.ac.uk 
l.clark@bugs.bham.ac.uk 

Techies, 
Bars, 
Security, 
Box office 

Room/ Event 
Bookings 

Lisa Clark Reception l.clark@bugs.bham.ac.uk Techies, 
Venues 
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Committee 
Training 

Counter 
staff 
Or VPSA 

Basement basement@bugs.bham.ac.uk 
vpsa@bugs.bham.ac.uk 

 

MV 
Accreditation 

Cassie or 
Fliss 

Basement c.manly@bugs.bham.ac.uk 
f.Harrison@bugs.bham.ac.uk 

 

Health and 
safety 

 Basement 
counter 

basement@bugs.bham.ac.uk  

Police 
checks/ child 
protection 

Involve Basement involve@bugs.bham.ac.uk Relevant 
bodies 

Transport – 
minibuses 
and cars only 

Lone 
(term time 
only) 

Basement l.dykes@bham.ac.uk University 
Transport 
Services 

Sponsorship Kat Tongue Marketing 
2nd floor 

k.tongue@bugs.bham.ac.uk  

Posters in the 
Guild 

Counter Basement basement@bugs.bham.ac.uk Promotions, 
Marketing 

Press 
Releases 

Counter Basement basement@bugs.bham.ac.uk 
 

President 

IT Rob 
Derbyshire 

IT office in 
Jobzone 

r.derbyshire@bugs.bham.ac.uk  

Constitutions, 
AGM, policy 

Megan - 
VPSA 

VPSA 
Office, 2nd 
floor 

vpsa@bugs.bham.ac.uk Relevant 
exec, 
Independent 
chairs 

Apologies for 
Guild Council 

Independent 
Chairs 

Admin 
Office, 2nd 
floor 

indchairs@bugs.bham.ac.uk  

Service 
Complaints 

Joe Rooney 
– Guild 
Users officer 

Exec 
Office 2nd 
Floor 

guo@bugs.bham.ac.uk Relevant 
senior 
manager 

Staff 
Complaints 

James 
Anthony - 
President 

President 
Office, 2nd 
floor 

President@bugs.bham.ac.uk General 
manager 

Community 
Issue 

Stu Mathers 
– 
Community 
Liaison 
Officer 

Exec 
Office, 2nd 
floor 

clo@bugs.bham.ac.uk  

Formal 
complaint 
about an 
executive 
Officer 

Independent 
Chairs 

Admin 
Office 2nd 
floor 

indchairs@bugs.bham.ac.uk Followed up 
by the 
Warden 

Sports 
bookings 

 Munro 
Sports 
Centre 

http://www.sport.bham.ac.uk/ 
membership/booking.htm 

 

Room 
bookings in 
the 
University 

 Student 
Services, 
Aston 
Webb 
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2. Running Your Society 
 

 
2.1 Equal Opportunities 

 
BUGS is here for all of our members and equal opportunities is therefore a core 
value.  The Constitution of the Guild of Students states that we will act “without 
regard to race, religion or creed, sex, sexual orientation or disability”. 
 
Access 
It is important that every student group considers how accessible they are to all 
students.  You must ensure that every opportunity you offer is open to all 
students as far as practically possible.  This means going beyond simply allowing 
all students to participate.  It is important that your activities do not put a barrier 
to participation. This may be in the way events are organised or in the actions of 
other members.  We do not expect all groups to be fully representative of the 
student population, different students have different interests, but we do not 
expect there to be any barriers to interested students. 
 
Safe Space 
BUGS offers a safe space to all student (and staff or visitors) in all its activities.  
This means that all students should be able to be as comfortable as possible and 
nobody should be subject to abuse or derogatory remarks.  This includes remarks 
that to one person may seem a joke but to others are offensive such as racist, 
homophobic, transphobic or sexist comments; or offensive remarks about people 
of different faiths or people with disabilities.  These will not be tolerated.  Failure 
to comply may result in disciplinary action. 
 
Students with Disabilities 
Students with disabilities face many obstacles to involvement.  Some of these will 
be more obvious such as lack of wheelchair access, or more subtle such as the 
font size of literature. As well as ongoing efforts to make yourself accessible, if a 
student with a disability want to get involved in your group you MUST make 
‘reasonable adjustments’ to enable them to get involved.  For help and support 
please ask the Basement Counter.  Alternatively the Students with Disability 
(SWD) Association can be contacted on swd@bugs.bham.ac.uk 
 
Lesbian, Gay, Bisexual or Transgendered Students 
The main barriers to access faced by LGBT students are actual or perceived 
discrimination.  Many of the steps to be taken are covered under safe space.  It is 
important that your group promotes itself as open and welcoming.  Why not 
contact the LGBT Association lgbt@bugs.bham.ac.uk  
 
Gender 
Many groups fined it hard to recruit either men or women.  All societies must 
allow both men and women into membership.  Again this is one about perceptions 
much of the time and the image you give off.  A too masculine or too feminine 
appearance may be putting them off.  Women also face the barrier of sexism, for 
more information contact womens@bugs.bham.ac.uk  
 
Mature Students 
Mature students can have different wants from a society but may be interested in 
your activity.  Consider the impression you give off, would it put mature students 
off. Will you only be asking the young looking people at Freshers Fair and missing 
the Mature Students? You can contact the mature students committee of the 
Postgraduate and Mature Students’ Association on msc@bugs.bham.ac.uk 
 
 
 

- 13 - 



Student Group Handbook 04/05 

Students of Faith 
Many students have different faiths.  The faith societies can be a great source of 
support in helping you to become more open to those students. 
 
Excluding students 
If your society feels it is appropriate not to restrict its membership this can only 
be done with the approval of Guild Council by absolute majority and needs 
renewing every three years.  The only society which is currently allowed to 
exclude students is Nightline which can exclude students who have not completed 
their training. 

 
2.2 Resources 

 
As a committee member you are responsible for keeping your society going and 
publicising your activities to your members. This section will give you all the 
information you need to do this successfully. 
 
As a BUGS recognised society you have: 
 
• A pigeon hole 
• A society email which will be societyname@bugs.bham.ac.uk 
• A webpage http://students.bugs.bham.ac.uk/societyname 
• Access to basement staff, services and PCs 

 
Pigeon Hole 
 
Your pigeon hole is located in the basement and this is where we will put 
important information, including details of students interested in joining your 
group and any post sent to your society. You can also use your pigeon hole for 
leaving information for other committee members or even for members of your 
society. 
 
Email 

• Free society email account  
• Web access for email at http://webmail.bugs.bham.ac.uk  
• Email forwarding to external accounts  
• External POP3 and SMTP access 

Use your email account as your primary means of communicating with BUGS and 
your members. If you don’t know what your username and password is ask at the 
Basement counter. 
 
You should check your email regularly to enable people to keep in touch with you 
and also to offer the best service to students you can, by replying to questions 
about your group quickly. BUGS will also send you important emails about 
changes in the basement which may require a response. 
 
How do I check my societies email outside of the Guild? 
 
• Go to the BUGS website www.bugs.bham.ac.uk 
• On the right hand column click on webmail 
• Type in your user name (the same as on a computer in the Basement) 
• Type in your password (follow the instructions for your computer version) 
• Check and reply to emails as normal 
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Webpage 

• Free web hosting with unlimited storage space and dedicated server for 
societies  

• Support for ASP and PHP  
• Access Databases, FrontPage Extensions and Perl available on request  

Your webpage is an excellent way to promote your society and communicate with 
members. They are very easy to update. If you find the instructions difficult to 
follow then please attend the website training at the societies conference on 
October the 23rd or 24th. 

2.3 How to design a simple webpage 

This is designed for people who know how to use a pc and that have access to the 
computers in student development. 

Start designing your page 

Your major tool in creating a web page if you've never designed one before is 
Front Page 2000 (Found in the office 2000 suite), those with a little more 
experience could try programs like DreamWeaver or HoTMetaL, but these aren't 
so user friendly for beginners. 
Once you start with Front Page 2000 you have a blank screen that looks, in some 
ways, familiar to that of your Word screen. Basically that's what it is. 
This is known as a wysiwyg program, this means that everything that you design 
on the blank page in front of you is what you will see on the finished web 
page(s). 
All the buttons at the top to centre, underline etc. text will work in exactly the 
same way as they do in Word.  
To give each page a title, click File>Properties. You change the title here. Also 
you can add a background sound for you page if you desire. By clicking the 
General tab you can change the background colour or add a background image to 
the web page. 

Do you want a picture? 

If you want to insert an image you have click Insert>Picture>From File. Web 
images have to be saved as of .gif or .jpg file extensions, these are the 2 main 
standards for Internet graphics. Most of the recent graphics programs have a 
'export to/as web' function that will do all the work for you. 

When designing more than one page on your site you will have to create each 
page in a new window of Front Page, save them all with a file name similar to the 
page you've created (eg. news.htm, home.htm).  
To link the pages together, open a page up in Front Page, highlight the text that 
you want to be a link to another page, then click Insert>Hyperlink then navigate 
to the page that you want to link to. This creates the link to another page. Doing 
this throughout the site will mean that users will be able to navigate through your 
site, without excess use of the back and forward buttons. 
Note: The home page of your website should be called index.htm as the 
servers know that this is the home page for your site. 

Your next step is to upload your web page to the servers 

To do this you will need to know your committee username and password. If you 
are unsure of the password, then ask the current committee. If you are on the 
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committee and you still don't know, then come to the IT office during the Drop-In 
hours, and we will change the password for you. 

Uploading your site from inside the Guild 

Just log in on the Basement computers and go to My Computer. You'll have a 
W:// drive, and this contains your society web folder. Just browse to your folder, 
and copy all the files in. Make sure your home page is called index.htm, and it 
should all work fine. Fingers crossed.....! 

Uploading your site from outside the Guild 

You will need to download a FTP Client if there isn't one on the computer that you 
are using.  
There are clients such as CuteFTP and WS_FTP, these are the most common and 
easiest to use. Install this program or run it and you should be presented with a 
logon window. 
In the server box type ftp.bugs.bham.ac.uk, in the username box type the 
username given to you by IT, and the same with the password box. It will then 
log you into the server and into your societies directory on the server. In your 
Local (i.e. Files on your PC, should be the Panel on the left directory) select all the 
files you wish to put onto the server, then right click and choose Upload. This will 
put the files onto the server and then you are done. 
Note: You can upload the files to the server from any computer in the 
world providing you have a connection to the internet and able to use 
FTP Programs. 
 
That's it, all done. You have created a very basic site and I strongly suggest that 
you have a look over the internet for any tutorials, examples, and help that could 
enhance your website, and who knows, maybe you could soon have the website 
you've dreamed of? 
If you need any further help or advice then don't hesitate to contact 
R.Derbyshire@bugs.bham.ac.uk. 
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2.4 Health and Safety 
 
As committee members of a BUGS society it is your responsibility to ensure the 
safety of your group whether it be for holding an annual dinner or if you are going 
on an over night trip. It is essential for you to fill out the following forms so that 
you are covered by insurance and so that should anything go wrong you won’t 
get the blame for being negligent.  
 
For further information about your group’s health and safety please see the 
health and safety booklet, which is available at the basement counter. Please be 
aware that it is also compulsory for a member of you committee to attend health 
and safety training on either October the 23rd or 24th October regardless of your 
activity! 
 
The following forms must be filled in. 
 
Risk Assessment – This form must be filled in for any activity you do whether it 
be a regular meeting in the Guild or a one off event to Alton Towers. 
 
If it is a regular event such as playing hockey once a week all year you can do 
one generic risk assessment for the whole year, adding to it should any incident 
occur. 
 
If you are holding a one off event, you must fill out a form just for that activity. 
 
Duty of Care – This from must be filled in if you are travelling in a vehicle or if 
you are staying somewhere overnight. 
 
This forms gives us all the information about your party should any accident occur 
is also provides us with information regarding first aiders and emergency contact 
details. 
 
It is essential that these two forms are filled in, you can get copies from the 
basement counter. 
 
One other form that you need to be aware of so that your equipment is covered 
by insurance is the Equipment Inventory. You must include all equipment 
bought with society money unless it does not have a life over a year such as 
stationary or paint. These are kept behind the counter and can be kept up to date 
by you when purchasing new equipment. 
 
More information can be found in the ‘Safety First’ booklet available from the 
Basement Counter. 
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2.5 Minibuses 
 

Through the University BUGS offers all groups a car and minibus hire service from 
the counter.  
 
How do I book a minibus? 
 
Go to the basement counter with the details including; name of driver, times, 
journey and number of people travelling a week before your journey and Lone will 
book a vehicle for you. You need to tell her which society it is for and which 
account the money is coming out of. If you haven’t driven before you need your 
card and paper licence. 
 
For any vehicle booked you must pay a £25 deposit. This must come from your 
own money. It will be returned if all forms are filled in correctly and no damage is 
done to the bus. 
 
Vehicles must be booked for the time needed. They will not be available before 
the hire time or one hours after the hire time unless you have contacted transport 
services in advance on 0121 414 6428. On return they must be back at the 
university by the time given. If they arrive late your group will be charged the 
extra. If another vehicle has been hired for another group to cover your lateness 
you will also be charged for that hire. 
 
How do I cancel a booking? 
 
Cancellations must be done at least 24 hours in advance, and by Thursday noon 
for weekend or bank holiday hires. 
 
Who can drive and how do we register drivers? 
 
As long as you are over 21 and have held a clean licence for at least 2 years, you 
can drive and hire a car. To hire a minibus you must also take and pass a minibus 
test which includes a theory and practical test which can also be arranged at the 
counter. To register you must bring in both your card and paper copy of your 
licence. The drivers licence will be checked every 6 months, in the interim period 
any changes to the licence including entitlements/ conditions eg points must be 
given to Lone at the Basement Counter. 
 
Can we pay people to drive for us? 
 
In a word no! Any payment made is illegal because it invalidates the drivers 
licence. 
 
Who pays for minibuses? 
 
From this year societies do! You are now responsible for paying for your tests, 
hire and fuel (unless given in your grant).  Prices can change so please go to the 
counter for current charges. 
 
It is also the drivers responsibility to pay any fines, parking tickets etc 
 
What about damage? 
 
Any damage which happens to a vehicle while in your care and booked under 
your societies name (including when parked on your journeys) is your societies 
responsibility and your group must pay for all of it. Any loss of hire due to a 
vehicle being fixed may also be charged. 
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Damage includes:  
• A muddy or dirty minibus 
• Not having a full tank of fuel/ putting in incorrect fuel 
• Rips/ damage/ unclean seats and interior inc rubbish 
• Damage to the vehicle including scratches/dents 
• Missing hubcaps 
• Damaged/missing Ariel 
• Bumper missing 
• Lights having been left on 
• Drained battery 
• Damage to rear steps 
• Damage to towbars/ electrics 
• Damaged/ punctures types/ wheel trims 
• Damaged screens/ windows 
• General misuse 

 
This list is NOT exclusive –  please leave minibuses in an impeccable condition 

 
How do we collect the Vehicle? 
 
• The day before your journey (or before) you (the driver) must go to the 

counter and collect a key release form – this allows you to collect your vehicle, 
and both damage report forms.  

• Then on the day of your booking if your booking is between 9 – 4.30 Monday 
– Friday (except bank holidays) the driver collects the keys and vehicle from 
Transport Services (opposite engineering on the south west side of campus). 
At all other times collect the keys from University Security (24 hour 
information services, behind Aston Webb) then collect the vehicle from Low 
Hill. 

• The driver must have the key release form and their University ID card with 
you to collect a vehicle.  

• You must collect a vehicle within ONE hour of the hire time or the vehicle may 
no longer be available. If for any reason you know you are delayed ring 
transport services on: 0121 414 6428. 

 
What do we have to do before leaving Campus? 
 
• If you are unsure where things are in the vehicle i.e. lights etc ASK before 

leaving. 
• Make sure it has a full tank of fuel (this will be filled to the neck)– if not ask 

for it to be filled to the neck of the tank– show a staff member from transport 
services or call them on 0121 414 6428 to inform them. 

• Make sure you thoroughly check the car/bus BEFORE driving and mark any 
internal or external damages, however small, on the report form.  

• If there is existing damage on the vehicle which is NOT on the collection form 
mark it with red pen and call Transports services on 0121 414 6428. BEFORE 
leaving and leave a message stating the exact damage, the society name, 
you’re name and the date and time. 

• Make sure that the damage report form which you hand in after your journey 
also has any existing damage marked on it before you hand in the form. 

• Hand the damage form into Reception at the Guild, make sure it is times and 
dated by a staff member, if reception is closed ask 24 hour security to sign, 
time and date it and hand it in to the Guild as soon as it is open. 

 
What do we have to do while on the journey? 
• Make sure all people wear seatbelts and keep the vehicle clean (you will be 

charged for mess including mud!). 
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• You are responsible for making sure people behave responsibly while you are 
driving.  

• When leaving the vehicle make sure all lights are off, windows shut and doors 
locked.  

• If parking in car parks make sure you check the height of the minibus FIRST. 
• Make sure no alcohol is carried or consumed in the vehicle 
 
What do we do if we have an accident? 
 
• First treat vehicles as if they were your own – please drive CAREFULLY.  
• However is an accident does happen call  transport services on 0121 414 

6428 and follow the details on the forms given to you by the Basement.  
• Be HONEST about any accident and put details and damage on the damage 

report form  
• Failure to fill out the form honestly will mean that we can’t represent your 

views to the University and your society will be charged for the damage. 
 
What do we do when we get back? 
 
• Fill it with fuel (make sure it’s the right one) to the neck of the tank. Failure to 

fill it will result in the University filling it at approx 90p per litre  
• Clean the inside (and outside if dirty) 
• Fill in the damage report form, marking existing damage in one colour and 

new in another and hand in at Guild reception where staff will sign, date and 
time it. If the Guild is closed ask 24 hour security to sign, time and date it and 
hand it in to the  Guild as soon as it is open. 

• Hand vehicle and keys back in 
• Notify the Basement of any problems/ damage ASAP 
 
 
What happens if the University contacts us to say the vehicle is 
damaged? 
 
Charging the damage (where all forms fill in correctly) 
 

• On receipt of estimate from University your society will have to meet with 
the VPSA/ VP Sport  

• Your current account will then be charged the estimated cost 
• If this results in an unauthorised overdraft you meet with VPS/VPSA to 

sort payment 
• When the vehicle is repaired (this may take a while) you will be notified of 

the true cost  
• Cost is rectified by either further charges or reimbursed  

 
Charging damage (where forms were not filled in) 
 
• You take responsibility for driving. If forms are not filled in your group will be 

charged for damaged which the University says has been done to the vehicle. 
This money will come out of your current account. 

 
How do I get my deposit back? 
 
Deposits will only be returned if all forms are filled in correctly and handed in both 
BEFORE and AFTER the journey and when there is no cost incurred for fixing a 
damaged vehicle. 
 
All vehicles are hired through Transport Services at the University. Their 
decision over damage is final and they can refuse the right to hire. 
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